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Abstract—Easy Java Image Processing (EJIP) is application
for image processing using java language programming. While
image processing technique is a technique to do manipulation
and an image by programming. This application using methods
basic image filtering buffered image by making use of that has
already been integrated (built-in) on java 2D. A filter all packed
in the same package application just like the filter to adobe
photoshop, it just got an interface that with simpler and user
friendly. A filter that available on the application this among
others, bluring, sharpening, edge detection, negative, rotating,
scalling, contrast and brightness values and to support storage a
picture with a variety of formats (jpg, jpeg, bmp, gif, png)
commonly used by the public at large. From the results of the
making of the application of this EJIP, we can conclude these
applications support filtering image and file storage image many
simultaneously
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I. INTRODUCTION
Acceleration of technological development very quickly
became the main attraction for users, such as in the world of
photography for example. The emergence of a digital camera
as one of the sophisticated devices in the digital age raises a
very high interest for the public to capture every important
moment through the images in the form of photographs.
However, of these technological developments also pose a
problem in a good image processing, such as when a person
continues to collect photos in large numbers, it will make the
data storage space runs out. Besides other examples when one
wants to convert the image into other forms, but difficulties
when using applications that are used for such applications do
not apply the concept of user friendly. Easy Java application
Image Processing (EJIP) or can be called an image processing
application is one solution to these problems. EJIP application
is to apply the concept of user friendly and interactive products
that are objective reflects the concept, which facilitate
processing of the image.

II. LITERATURE REVIEW
A. Image Processing
Image processing or image processing is an activity of
improving the quality of the image to be easily interpreted by a
human/ machine (computer).
The input is the image and the output is also the image but
with better quality than the input image, ie the image of color
are less sharp, blur (blurring), contains noise (eg white spots),
and others that need no processing to improve the image
because the image becomes difficult to interpret because the
information conveyed is reduced. Illustration of the process is
shown in Figure 1.Java 2D
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B. Java 2D
Java2D provides several classes for image processing or
image filtering. Class image processing can be obtained
through the library java.awt.image.BufferImageOp. Here is a
table of available classes with effects that can be obtained.
Image

Image processing

Fig. 1. Image Processing Process

Previous applications have image processing concept has
also been made, such as applications Easy Graphic Converter
issued by EtruSoft Technology.
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TABLE I.

Class Name
ConvolveOp

IMAGE PROCESSING CLASSES

RescaleOp

Support Class
Java.awt.image.
kernel
Java.awt.geom.
AffineTransfor
m
Lookup Table,
ByteLookupTab
le,ShortLookup
Table
-

ColorConvert
Op

Java.awt.color.
ColorSpace

Affine
TransformOp
LookupOp

C. EJIP System Analysis
There are three main stages in the flowchart EJIP that
determine the occurrence of image processing, which opens the
file, the conversion process, and save the image file of the type
that has been determined.

Effect
Blurring, Sharpening,
edge detection
Transformasi
Geometri

1) Open File
The purpose of opening a file is to get kanditat EJIP.
The input of this stage can be 1 or vary any image file image
files, input file types can be shaped JPG, BMP, PNG, GIF etc.
Phase open this file is a preparatory step which will be
continued in the processing stage.

Posterizing, color, invertion

Brightening, darkening
Color Space
Conversion

1) Class ConvolveOp
ConvolveOP class is a class that do convolution
operation in the image. Convolution operation is an operation
where the pixel image produced is the sum of the original pixel
by pixel in the surroundings. This convolution operation is
done with the help of the kernel, which is the matrix
representing the pixels, which represents a central element
pixels source and other elements representing the pixels around
the pixel source.
2) Class AffineTransformOp
AffineTransformOp class is used to perform image
transformation operations, such as geometric magnification and
rotation. Constructors and AffineTransformOp are as follows:
AffineTransformOP (AffineTransform xform, int
InterpolationType);

There are two types of interpolation are provided, namely:
- Nearest Neighbour: the type of operation is faster, but
the quality is declining
- Bilinear: type of operation is slower but better quality
3) Class LookupOp
Class LookupOp basically used for mapping the pixel
color through a table (array) of type lookup table.
4) Class RescaleOp
RescaleOp surgery changes the color scale, for example
the color component of the pixel is x then rescale operation can
change the value of x becomes:

2) Filtering Process
This stage includes the process of selecting files that
have been, creation of new file types, and compresed image.
The election process this file depends on when the first phase,
while the manufacture of the new file type is a phase of
metamorphosis appropriate file associated user instructions.
In the image compression, image files will be
compressed or reduced in order not to burden the load data
peny¬impanan the data, basically this image compression
removes information that is not required in the image.
3) Saving Files
This stage to store files that have been processed in the
second stage, this stage is the finishing stage of the application
EJIP. At this stage also provided facilities Output To that
indeed serves as a director later files are stored.
The basic idea of Easy Java Image Processing (EJIP) is
the image processing in features like image conversion, image
compression, and edit images in the concept of user friendly
and interactive products, not just the application EJIP can
convert image much in time simultaneously, so it can be seen
that the relevant product excellence. EJIP stage of the process
is not really complicated, but in general, the application EJIP
take steps image loading, image filtering and image saving.
The application process it self, as in Figure 3, begins
with inserting/ input image file to be processed. Then choose
the type of filtering conditions existing image in the edit menu
is done. When selected blur filter, then the application will
performs the function of blur.
When selected sharpen filter, then the application will
perform functions sharpen, so next to the other. After stage
image processing is done then the image data is saved into a
new file (can be a variety of image file types). Once the
application process is complete.
III. IMPLEMENTATION AND TESTING SYSTEM

x (new) = a * x (old) + b
5) Class ColorConvertOp
ColorConvertOp class is used to perform color space
conversion, for example from RGB space to a color space gray
(gry-scale). The constructor is as follows:
ColorConvertOp (colorspace source, dest ColorSpace,
RenderHints rh);

A. Implementation of Library and Classroom
Implementation of libraries and classes refers to the
architectural description and classes that have been identified
in the literature review. Implementation of libraries and their
own using libraries java.awt.image.BufferImageOp the classes
that have been included in the application EJIP.
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B. System Architecture

Fig. 3. Load Image Picture

Fig. 4. Save Image Picture

b) Save
The second menu item is used to store the image
filtering results in a computer directory / other media. Display
save image shown in Figure 5.

Fig. 2. Image Processing Flow Chart

The implementation will yield forming elements filtering
the image, such as blurring, sharpening, edge detection, color
Invertion, Brighten, etc. Use of libraries and the class aims to
facilitate the grouping supporting components image
processing.
C. Implementation System
Implementation of this system refers to the system design,
so that the functions that have been designed to be applied to
physically into EJIP application form, the form of the
application interface is as follows:

c) Exit
Exit menu is used to exit from the user interface or
application can quickly key is Ctrl + E.
2) The Filter Menu
The filter menu is a menu that functioned as a picture
editor that utilizes filtering features are widely known image, in
this menu offered a variety of models designed in a simple
filtering.Display filter menu as shown in Figure 6, and the
results in Figure 7.

1) The File Menu
Menu file an initial menu in the interface of this
application, the file menu contains several menu items, such as
open, save, and exit.
a) Open
The menu item is used to insert the picture / image
loaded into the application interface EJIP, the objective that the
image can be processed in such applications as the interface to
use, open the image can also be done with a quick button, the
Ctrl + O. Display open image shown in Figure 4.

Fig. 5. Image Filtering Picture
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Fig. 7. Help Picture

Fig. 6. Display Filtering Result

3) The Help Menu
Help menu is a menu that contains the information
about the identity of the creator of the program that contains
the email address, telephone as well as data that support the
author information program, the purpose of this menu is
nothing but a penjebatani between the user and the
programmer, so that if there is trouble shotting, the user can
call programmer.
Within this menu is also provided about the menu item,
which function as instructions for using the application
manually, the goal that the user does not get confused when
using this application. About menu display shown in Figure 8.
4) System Testing
Tests performed as verification that the application EJIP
can be run in accordance with the design of the system has
been made. The main purpose of this testing phase is to find
errors that might occur when the application is running. There
are two types of testing methods are commonly used when we
want to test an application, namely white-box and black-box.
White-box testing emphasis on internal processes, while the
black-box testing more emphasis on system functionality.
In this application, use the black-box testing to see and
pay attention to the running program, in other words a
programmer tried every menu in the application.
From the test results the whole interface applications,
the results look goes well with other words not found error
refers to the application scenarios

Results of the implementation of the application indicates
that the application has many features of filtering image much,
the application also has the capability to store many files
simultaneously, and no less important this application has a
simple display, but the value of the benefit and ease of use are
very strong in this application.

V. SUGGESTION
To make the application more optimal image processing,
image filtering in the menu should be given some sort of
scrooling filter on each type of filtering image that has been
identified in the application, so pros¬entase filtering can be
controlled by the user.
In general, the output image filtering results using EJIP is
good enough, but to get more interactive, it is necessary for
quality measurement method, in addition to the comparison
should be made use of libraries or classes that support other
image processing, so that the results can be optimized.
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